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1.1 Variable Data Printing

Introduction

Variable Data Printing is printing of a set of documents with mostly shared elements, except for certain 
text, or images that change from document to document. In Flexi, this starts with designing a template by 
loading a sample file and assigning which elements are to be used for variable data, and then specify the 
data to be used to instantiate those elements. 

Besides image and regular text, barcode, data matrix, and Braille text can also be used for variable data. 

Variable Data Toolbar

The design tools for this can be accessed from the Variable Data Toolbar:

To open the toolbar, choose from the menu File > Variable Data. Or choose View >Toolbars, and check the 
box for Variable Data. 

Convert to Variable Data: This is the tool to assign a text or image to be used for variable data. 
Select one of such objects and then click on this tool to create a variable data object. Note that 
this should be done on a top-level object. For example, if a text object has an effect on top of it, 
the effect object should be selected instead, so that it will be applied to the substitutions. -> 



-> The tool used the following DesignCentral page for options:

Keyword: This is the string to identify this element, for title and for looking up the 
CSV data files.
Variable String: This is the part of the text that will be substituted. It can be a 
substring of the selected text.
Width & height: These define the clipping box of the element. If the substituted 
string or image exceeds this box, they’ll be either scaled to fit to this box or be 
clipped.
Scale to fit: If the instantiated string or image exceeds the clipping box, whether to 
scale it to fit.
Proportional: If there is a need to scale to fit, whether to have equal X&Y scales.
Alignment: How to position an image with smaller size.
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Edit Variable Data: This tool is for loading and editing data to be used for the variable data. It 
displays the following dialog:

1. Data list: It shows the date currently assigned.
2. New: Add a new entry. Click on the data list to type the strings directly.
3. Delete: Remove the selected entry.
4. Clear: Remove all entries
5. Load Data File: Add the data from a text file (tab delimited) or a CSV 
file.
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Important note: You are able to drag and drop images into the dialog 
box and this will save you time from typing them into data edit or cvs file. 



Open: Open a template (from the /Variable Data folder).

Save: Save the Variable Data template.

Save as: Save the current document as a Variable Data template.

Preview: Display the pages after the data has been applied.

PDF Export

After the data has been applied, the document can be exported as a PDF file that can be added to 
Production Manager for output.
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1.1 Variable Data Printing

RIP and Print Dialog Variable Data Page

The data can be loaded instead (or further edited) in the RIP and Print Dialog, on the Variable Data tab. It is 
similar to the Edit Variable Data dialog from the main design window, except for 2 additional options: 

- Apply Variable Data: Whether the data will be applied or just printing the template.

- Preview: Whether to display the final pages after applying the data in the preview window. 

The data added here is also saved with the .fs file.
Switch the preview mode to “Page Preview” to 
browse through the pages.

Note: When the job is sent to Production 
Manager from here, the data is applied and can 
no longer be edited. But Production Manager 
can display the final output pages for this job.
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Production Manager Variable Data Page

The Variable Data template (or .fs file) can also be used in Production Manager to generate variable data 
output. To do that, add the .fs file to the job queue, and open Job Properties dialog for this file. It will have 
an extra tab for assigning and editing the data, which is similar to the one in the RIP and Print dialog. Use 
the page preview to browse through the pages.
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1.2 Printing Files as Layers

Introduction

With Flexi 21, you can create and print layered jobs that is made of two or more separate files for printers 
that would support printing multiple layers. Usually for printers with Spot colors like White and Varnish. 
You can also preview layers in Job Properties.

Workflow

To create layered job, you would usually prepare different 
files for color files and separate files for spot colors, like 
White and Varnish. After you add jobs to Production 
Manager you would select all jobs you intend to print as 
layers, right click on selected job and choose “Create layer 
job” option. You can also add three or even more jobs in 
case the printer has more spot colors. 

Note: Files must be exactly the same width and height. 
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In Layer Setup dialog, you can define what job for which color use.
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Settings can be changed in the Layer Tab.

Note: When you use the option “Create layer job”, the driver will pick up the spot settings of the first job. 
So you’ll need to check the Spot Settings in the Driver Tab.  

Some brands as HP, Ricoh,.. do have some more specific settings because they support “front, middle 
and back” layers. 
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1.3 Adobe Illustrator® Layer Support

Introduction

This is a new feature in Production Manager allowing a multi-layer pdf to be split into multiple pages (one 
page per layer). 

Split job by layers

After adding a pdf job, if it has multiple layers, 
the context menu for the job will include an 
option to “Split job by layers.”
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Upon selection, a popup dialog shows a list of all the layers in the job and allows the user to select which 
layers should be printed, and if spot colors are present, if they should print as standard color or spot color.

The print job is then converted into a Layer job.
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1.4 JIG Templates

Introduction

The “Jig Layout”  feature is for arranging the jobs to be printed on a substrate with specific size and 
regions. It handles also fitting of the jobs to the areas of those regions, as well as alignment.

This can be applied to multiple copy jobs and nested jobs.

Access to the feature

This feature can be accessed from Production Manager, from both 
Default Job Properties and Job Properties dialogs, at the bottom of the 
Layout tab.

The “Apply jig layout” checkbox specifies whether a jig layout will be 
applied to the jobs. The “Define Jig Layout” button launches a dialog (to 
be documented later) to edit or define new jig layouts.
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Jig Definition Dialog

The dialog displays the current jig layout and allows editing of it. As well as saving it as a preset, or import 
from or export to external files.
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1. Presets: These controls are used to select a preset
defined previously, or to save, load, delete, or 
rename that. It can also import and export them as 
.jigpst files to be transferred between different 
installations of Flexi. The functionalities of the 
buttons are displayed as tooltips.
2. Media Size: These controls are used to specify 
the size of the whole substrate, as well as the 4 
margins.
3. Jig Size: These controls specify the dimensions 
and margins of each jig. The option “fits jobs to jigs” 
indicates whether the jobs should be resized to fit 
the jigs. “Fit proportionally” indicates whether the 
jobs that need to be scaled will be doing so 
proportionally. ->
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->
4. Spacing: These controls specify the spacings between jigs. 
5. Origin: This indicates the zero point of slot 1.
6. Alignment: These controls specify how the jobs will be positioned if they don’t fit both dimensions of the jigs.
7. Preview: This control shows how the layout looks like.
8. Print Jig Layout: It prints the outline (media size) plus the jig slot outlines.

Example

Here’s an example of how a jig layout is applied.
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1.5 Enhanced print while RIP

Introduction

With enhanced Print while RIP you do not have to wait for job to finish ripping to start printing. Enhanced 
Print while Rip will let you faster process big jobs but also nested and tilled jobs. Print while RIP can be set 
in Production Manager by going to Edit >Preferences and checking Print while Rip check box.
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1.6 Output Size Compensation per preset

Introduction

Output Size Compensation allows you to measure slight variations in 
output size and compensate for them. In earlier versions of Flexi, you 
had to set the Output Size Compensation separately for each device. In 
Flexi 21 you have option to set the Output Size Compensation 
separately for each media and save it as part of the preset. Output Size 
Compensation option is accessible from the Setup menu in 
Production Manager.
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Workflow

1. Click the Setup menu button and select Output Size Compensation. 
Enter the Width and Length of the test cut you want to output under Test 
size. For best results, the print should be as large as possible while still 
fitting onto the output media.

2. Click Test Print. Measure the actual size of the test print and enter the 
Width and Length of the test print under Measured size. The software 
automatically calculates the compensation factors that will scale the output 
size to compensate for the difference between the test size and the 
measured size.

3. Check Enable output size compensation to automatically scale all 
future output from this setup using the compensation factors derived from 
your measurements. In case that you want Output Size Compensation to 
be applied only to one substrate click on “Save in preset” option and 
select preset you would like Output Size Compensation to be saved in.  
Note that in the order for the Output Size compensation to be saved in 
preset you should either select one of the existing presets or create new 
preset before the Output size Compensation is performed.
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1.7 Output Channel Preview

Introduction

Output Channel Preview lets you preview print job per output channel before it is 
sent to printer. Job does not even have to be ripped. It is powerful tool for eliminating 
mistakes especially when printing spot channels like white and varnish.
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2.1 G7 Certification

Introduction

This is a new option in Color Profiler Gray Balance step, to generate linearization that is closer to being 
compliant with the G7 standard.

It might be necessary to go through multiple iterations to achieve better results.

Quoted from ColorLogic documentation:

“G7 is an approach to linearize an output system to get well defined print characteristic. It is a different 
method of channel-wise linearization.”

More information about the G7 standard can be found from the following link:

https://www.suttle-straus.com/blog/what-does-it-mean-for-a-printer-to-be-g7-certified

https://www.suttle-straus.com/blog/what-does-it-mean-for-a-printer-to-be-g7-certified
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Workflow

The workflow is similar to regular profiling, except for the Gray Balance step.

1. In the Profile Setup tab, select the “Enable Gray Balance” option. 
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2. Continue profiling, till the Gray Balance step.

3. Select the option “G7 Linearization” and choose the type.
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4. Print the target and then measure.



2. Color Management
2.1 G7 Certification

5. “ Print Verification” to check the gray balance.
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6. To verify the result of this transformation, start the verification tool by clicking on the “Verify” button.
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7. Print and scan the verification target.

8. Check the Delta-E values.
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9. For further adjustment, click “Start Next Iteration”, and repeat step 4 to 6.

10. Once that’s done, continue profiling as usual.
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G7 Linearization options

There are 2 types to select from, “G7” and “G7-graybalance”.

Descriptions about these 2 methods are the following:

"G7": G7 linearization including CMY - Gray - Balance(neutrality), CMY - NPDC(Density), Black -
NPDC(density) and spot color linearization(ISO 20654)

"G7-GrayBalance" : G7 linearization only correcting for CMY - Gray - Balance(neutrality)

So the 2nd option is a subset of the 1st one.

Preview of non-G7 linearization curves

Preview of non-G7 linearization curves has also been added:



2. Color Management
2.2 DeviceLink Profiler

Introduction

In a normal color correction workflow, input colors are first converted to a device independent color
space (such as Lab) through input profiles, and then to the output color space through output profiles.

This direct conversion facilitates some special handlings such as preserving pure colors. It can also be 
used to simulate the output from one printer on another one. These account for 2 types of DeviceLink
profiles that can be created with Flexi DeviceLink Profiler, input to output DeviceLink, and printer to 
printer DeviceLink.

Most of the functions can be found in the software CoPrA from ColorLogic, and here is a link to their 
documentation with more detailed descriptions:

http://onlinehelp.colorlogic.de/en/copra-devicelink-profiling/

http://onlinehelp.colorlogic.de/en/copra-devicelink-profiling/
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DeviceLink Profiler Home Dialog

The DeviceLink Color Profiler can be accessed from the Setup menu as well as the contextual menu for a 
setup. It launches the following dialog, which provides 3 options: 

1

2

3

1. Create a new DeviceLink profile.

2. Edit an existing DeviceLink profile.

3. Optimize an existing DeviceLink profile through iterations.
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Creating Profiles

1) To create a DeviceLink profile, first select a source and a destination ICC profile. The source profile 
can be an output profile for another printer, or a CMYK or RGB input profile.
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2) Next, specify rendering options, such as: Rendering intents, Chroma, saturation and lightness 
adjustment, gray balance adjustment.
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3) Next step is to specify black generation options. Most of them are similar to the regular Color profiler, 
and here are some of the additional ones:

1. GCR amount: Defines the amount of CMY that is replaced 
by black. At 0 only a low GCR amount is used which mainly 
impacts the shadows whereas at 100 a very strong GCR is 
used which effects the shadows and the highlights.
2. Advanced Option:
Regular: No special GCR processing
Preserve Separation: Preserves the ratio between the black 
channel and CMY composed black.
Note: The black generation mode Preserve Separation is 
especially important for conversions between similar CMYK 
printing processes (conversions between two offset presses 
or two inkjets of the same model etc.), because it ensures 
that the ratio between CMY and black which is used to 
generate gray is maintained in the color conversion.
Preserve black : Linearizes the black value of the source 
profile and retains the black channel.
Save ink : Replaces CMY colors by black to save CMY inks.

1
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3. Black control range: Controls the transition to black. If 
black exceeds the limit, CMY colorants will not be modified 
and black is linearly added. Up to the specified value black 
will be calculated accurately. A value of 0% indicates that 
only CMY will be converted whereas black will be linearized. 
If a proof requires an exact colorimetric reproduction the 
slider should be set to 100%. 80% is a good value to achieve 
a smooth transition in the shadows. We recommend to 
activate the checkbox Auto. 

3
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4. Black Calculation: 
Auto: The calculation of the optimal black point (dark and 
neutral) is based on the target profile. The values entered for 
Black TAC and Max.Black define limits which are not exceeded 
but may be lower if technically possible. All channels are used to 
generate the black point (Black TAC), therefore individual channel 
editing is disabled. This mode will not use any Multicolor
channels beside the first four channels (usually CMYK).
Note: If no default value for the Black TAC is defined, it is 
recommended to use 400% as a starting point for the calculation.
Balance CMY: This setting adapts the CMY values to a pre-
defined Max.Black value and generates a neutral black point. 
Define the Black TAC and TAC in accordance with the printing 
conditions. The Max.Black should be set to the ideal value for 
your substrate. Similar to the setting Auto those values are 
regarded as maximum values which may be underrun if a neutral 
black point is not achievable. Allows customization of the black 
channel (or in general the 4th channel) and the addition of 
Multicolor channels.
->

4
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->
AutoCMY: This setting locks the black channel and optimizes 
(reduce+balance) CMY to get a neutral black point.
Target Profile: Calculates a black point based on the values of 
the target profile.
Target Profile Auto: This setting uses the black point and TAC of 
the target profile and optimizes it with the "Auto" method
Custom: Allows to define the black point in the input box 
Custom as CMYK values. The Black TAC value will then be 
recalculated. Allows editing of all channels.. 

4
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4) Next step is to specify preserving purehue options.
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5) The final step is to choose ICC profile options and generate the profile.

Editing Profiles

To edit a DeviceLink profile, first browse for the profile, and then following similar steps as above to make 
changes and re-generate the profile.
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Optimizing Profiles through Iterations

This step is to improve a DeviceLink profile by measuring a target with the DeviceLink ICC applied, and 
regenerate the profile.

4

1. Browse for the profile to be optimized.
2. Choose the measurement device.
3. Choose a target and print.
4. Measure the target. The Delta-E (maximum and average) will 
be calculated and displayed. 
5. Click one the button “Details” to view the Delta-E for the 
individual swatches.
6. To save the profile for this iteration, click on the “Save” Button.
7. To start another round, click on the “Stasrt Next Iteration” 
button and repeat steps 3 to 6.
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Applying DL Profiles in Flexi

The DeviceLink profiles can be selected from the Color Settings dialog of the RIP and Print dialog (the 
same dialog where input profiles are selected). ->
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->

Different DeviceLink ICCs can be assigned to different object types:

1. Override input profiles: If selected, the input profile 
selected from the first tab will be ignored and only the 
DeviceLink profiles will be applied. If it is unchecked, a new 
DeviceLink ICC will be created connecting the input profiles 
to the output profiles.
2. Override document embedded input profiles: 
If checked, the embedded ICCs in the document will be 
ignored, and apply only the DeviceLonk profiles. If 
unchecked, a new DeviceLink ICC will be created connecting 
the embedded profiles to the output profiles.

Note: Even when DeviceLink profiles are used, the 
linearization profile still comes from the output profile 
selected in the main tab, so it is important to select the 
matching destination profile as output profile there.

1
2
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Applying DL Profiles in Production Manager

Similarly, the DeviceLink profiles can be selected from the Color Management tab of the Default Job 
Properties and Job Properties dialogs.

The options are the same as those from the RIP and Print dialog. It is also necessary to select the matching 
destination profile in the main tab (for linearization ICC).
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Introduction

Here is an example of the custom color mode workflow. Let's suppose that a customer modified the 
printer and is changing its ink set (CMYKOrGrW) by replacing Orange and Green by Fluorescent Yellow 
and Pink and using these color as process colors. 

Workflow

1. From the Color Management Tab in Default Job Properties, open 
Custom color mode dialog.
2. Set the original custom ink set as the Reference Color mode. Replace 
the old colors by selecting new ones using the ColorPicker. Choose any 
color name for the new colors, set the color channels as Process and 
save it. 
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2. Set the original custom ink set as the Reference Color mode. Replace the old colors by selecting new 
ones using the ColorPicker. Choose any color name for the new colors, set the color channels as Process 
and save it. 
3. Your custom color mode will show up in the color mode list. 
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Creating ICC Profile

1. In the Color Profiler dialog, select the new color mode to create a profile with it. 

2. In rare case that some channels have wrong order in the Ink Limit Chart, go back to the custom color
mode dialog in Default Job properties and set the right order for incorect channels.

3. Print the Ink Limit Chart again to check whether the color order is correct. Then continue the profiling process. 

Note: A given channel can be Process, Light, Spot or None. For Light channels, the custom color name must start 
with "Light" followed by its dark color name ("Light Green"). The channels that are assigned to "None" will be 
deactivated and not used in the Rip process or printer output. 
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Introduction

This feature allows users to specify output colors for certain colors (similar to Object Color Control), but 
instead of replacing just those exact colors, they are applied to the color correction object as “trafo
correction”, which adjust the adjacent colors within chosen range. 

Define color mappings with OCC

To map the colors specific to a job, specify 
them in the Job Properties dialog OCC tab.

Check the option “adjust also similar 
colors” and choose the range (of the colors 
to be affected).

These mappings will be stored with the 
jobs, and can be transferred with presets.
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Store Color Mappings with ICC’s

The color mappings can also be specified and stored with output ICC profiles.

Here are the steps to do that:

1. Select from the Setup menu the 
command “Color Profile Adjustment”

2. Browse for the profile to be modified.

The list of color mappings associated 
with the profile will be loaded.
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3. Click “New” to add a new mapping or 
click “Edit” to modify an existing one.

4. Choose the range of adjustment and 
click “OK” to save the changes.

Note: If mappings for the same colors 
are defined in both the job and the ICC 
profile, the ones in the job will be used. 
Same with the range.
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3. Contour Cut
3.1 Manual Contour Cut Offset

Introduction

For cutters without automatic registration mark system to improve accuracy of the contour cut.



3. Contour Cut
3.2 Custom Contour Cut Line Name and Color

Introduction

In Flexi 21 you can create your own, custom, Cut Contour colors and assign specific cutting condition to 
each color. Flexi uses certain pre-defined spot colors to identify cut paths from EPS and PDF files, such as 
CutContour, PerfCutContour, etc. The paths with such colors for stroke or fill will be processed as cut 
paths. 

This feature extends this functionality so that for each device, it can define a set of spot colors with 
custom names (besides the ones mentioned above) to be used for cut lines in EPS and PDF files. It also 
associates them with specific output options. 
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Define Cut Contour Colors and Output Options for a Setup 

Custom cut contour colors can be defined in the Cut tab of the 
Default Job Properties dialog. 

Click on the Set Cut Line Color button to add a new cut color. 
It’ll display the following dialog, in which one can specify spot 
color name, associated cut option, as well as display color: 

To edit an existing color, select it from the color list and click on 
that same button, which will display the same dialog as above 
to edit the information. 

To delete a color, select it and click on the button with the 
delete check mark. 
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Apply Cut Line Colors 

Once the cut colors are defined, select the cut setup from the Default Job Properties dialog of the printer 
setup as usual: 

Define Cut Contour Colors and Output Options for Jobs 

Besides defining the cut colors for the setups, it can also be done for individual jobs, from the Cut tab of 
the Job Properties dialog. Click on the Set Cut Line Color button to add or modify a color, or use the delete 
button to the right to delete one.
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3.3 Artboard Contour Cut

Introduction

The Artboard Contour Cut feature will let you add cut line to the file in Production Manager without need 
to create cut line in Flexi Designer or in third party design applications. This feature is to allow cutting 
around the jobs even when it does not have a cut path. And because of this, it can be applied to any file 
type including to raster formats (such as TIFF or JPEG).
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How to set the Arboard Contour Cut

Artboard Contour Cut option is set at Job Properties 
dialog from Workflow tab. Once you choose what 
device cut file will be sent too, check “cut along 
page border” option and cut line will be applied to 
the job page border. You can use margin option to 
offset cut line away from page border or, if you 
choose negative margin, top shrink cut line in from 
the page border.

Cutter registration marks will be applied 
automatically based on your device setting.

After the print job is sent to the printer, cut job will 
be created in the cutter queue
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3.4 Cut Jobs with Barcode kept in hold

Introduction

Contour Cut jobs with barcodes will, by default, be kept in the queue after the output in case that job 
needs to be reproduced thus saving substrate and time.
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3.5 Graphtec Barcode Support

Introduction

Full support for Graphtec Datalink and Barcode System via Datalink Server in Production Manger 21.
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3.6 Summa/HP OPOS Xtra Mark

Introduction

Full support for Summa and HP plotters OPOS Xtra Mark for better accuracy.
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3.7 Contour Cut line preview in Production Manager

Introduction

Contour Cut Line can be previewed separate from the artwork to check for correct contour cut line. 
Preview is available in the Production Manager for files with Contour cut line added directly to Production 
Manage or for hybrid jobs sent from Flexi.
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4.1 Improvement to Job Info and Job Template

Introduction

Three major changes were made to Flexi’s Job Info tool: added support for custom fields, a resizable job 
info dialog, and editing capabilities for template borders.

Custom Job Info Fields

Custom fields can now be added to the standard list of fields previously available. These fields can be 
added in either of two places: a new button on the Job Information dialog, or a new option in the Job Info 
Template subcategory dropdown menu. Custom fields are added as options to both locations in the UI. 
They are also saved to the client’s preferences, so they will persist across documents and sessions.

Custom fields function just like any other field. They will save with the document, can be used for making 
templates, and are even searchable in the Find File tool.

There is no way to remove custom fields in the UI, but if the client needs to, they can be removed 
manually from the preference file saved at “Application/Jobs and Settings/jobinfofields.pref.” 

Note: However, be aware that manually editing this file can cause documents saved under a previous 
version to lose the custom job info data for those fields.
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Resizable Job Information Dialog

Previously, the Job Information dialog box was a fixed size, and when clients entered long values, not all of 
it would be visible. This dialog box can now be resized as large as the client wants, and the edit box fields 
will scale to match the window. (Most fields only scale by width, but the Comments and Description 
boxes also scale in height.)

Note: What previously was the fixed size is now treated as the minimum size.
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Template Borders

This is discussed in more detail in “Block Text for Templates (12018)” below, but essentially this adds the 
capability of defining a border for template fields. This is mainly useful for wrapping text to ensure that 
longer descriptions, comments, etc. fit and display well when the template is applied.

Block Text for Templates (12018)

A new button has been added to the Job Info 
template edit tool which allows clients to enable 
and edit the template border. Many existing 
template files do not have borders enabled for 
their placeholders, but this new tool allows them 
to be enabled (and their dimensions changed) so 
long text values can wrap within the desired 
bounds.

After enabling the border, and setting its size, the 
job information will now wrap within the border 
as shown in this example.
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4.2 User Data Backup

Introduction

Flexi 21 will let you import user data like ICC profiles, preset, preferences and templates from previous 
installation. You can also make backups of your data and reload data into new or existing installation.

Workflow

In Flexi, go to menu ‘Edit -> ‘Preferences’.  On the bottom, you’ll 
find a new menu button called:  ‘Backup..’. Click the button to 
open the Backup Options dialog. 



4. Extras
4.2 User Data Backup

In the Backup Options dialog, you can set up the 
Backup Folder destination. Change the 
destination folder by clicking “Browse..” or copy 
paste the link of the folder in the destination field. 

As well, the Flexi user can decide which settings he 
wants to backup. In this case, all Flexi and 
Production Manager settings are Auto Backup 
every 30 days. 

The Flexi user is also able to Backup the settings 
immediately via the Backup Now button. 



5. Feature Overview



Flexi Sub Flexi Design 
Sub

FlexiSIGN & 
PRINT 

FlexiDESIGNER FlexiPRINT FlexiSIGN FlexiPRINT SE FlexiSIGN SE FlexiDYESUB

Variable Data 
Printing ● ● ● ● ● ●
Printing Files as 
Layers ● ● ● ●
Adobe Illustrator 
Layer Support ● ● ● ●
JIG Templates ● ● ● ●
Advanced RIP while
printing ● ● ● ●
Output Size 
Compensation per 
preset

● ● ● ●
Output Channel 
Preview ● ● ● ●

5. Feature Overview
Production



Flexi Sub Flexi Design 
Sub

FlexiSIGN & 
PRINT 

FlexiDESIGNER FlexiPRINT FlexiSIGN FlexiPRINT SE FlexiSIGN SE FlexiDYESUB

G7 Certification ● ● ● ●
Device Link 
Profiling OPTION OPTION OPTION OPTION

Custom Ink Sets ●
Adjust Color
Transformation with 
Color Mappings

● ● ● ●

5. Feature Overview
Color Management



Flexi Sub Flexi Design 
Sub

FlexiSIGN & 
PRINT 

FlexiDESIGNER FlexiPRINT FlexiSIGN FlexiPRINT SE FlexiSIGN SE FlexiDYESUB

Manual Contour 
Cut Offset ● ● ●
Custom Contour 
Cut Line Name and 
Color

● ● ● ●
Artboard Contour 
Cut ● ● ● ●
Cut Jobs with
Barcode kept in 
hold

● ● ● ●
Grapthec Barcode
Support ● ● ● ●
Summa/HP OPOX 
Xtra Mark ● ● ● ●
Contour Cut line 
preview in PM ● ● ● ●

5. Feature Overview
Contour Cut



Flexi Sub Flexi Design 
Sub

FlexiSIGN & 
PRINT

FlexiDESIGNER FlexiPRINT FlexiSIGN FlexiPRINT SE FlexiSIGN SE FlexiDYESUB

Improvement to 
Job Info and Job 
Template

● ● ● ● ● ●
User Data Backup ● ● ● ● ● ● ● ● ●

5. Feature Overview
Extras



SAi HQ North America - info@ThinkSAi.com | 1.800.229.9068 | 801.478.1900

SAi Europe, Africa, & Australia - eu-info@ThinkSAi.com | +32 2 725 52 95

SAi Latin America - la-info@ThinkSAi.com | + 11 2951-6228 | 98556-8198

SAi Japan - japan-info@ThinkSAi.com | + 81 463 60 3804

SAi China, Hong Kong, & Taiwan - china-info@ThinkSAi.com | +18621189970

SAi SE Asia & Middle East - asiame-info@ThinkSAi.com | +91 88 88 33 22 77

www.thinksai.com


	Slide Number 1
	Index
	Slide Number 3
	1. Production�	
	1. 		Production�1.1		Variable Data Printing
	1. 		Production�1.1		Variable Data Printing
	1. 		Production�1.1		Variable Data Printing
	1. 		Production�1.1		Variable Data Printing
	1. 		Production�1.1		Variable Data Printing
	1. 		Production�1.1		Variable Data Printing
	1. 		Production�1.2		Printing Files as Layers 
	1. 		Production�1.2		Printing Files as Layers 
	1. 		Production�1.2		Printing Files as Layers 
	1. 		Production�1.3		Adobe Illustrator® Layer Support
	1. 		Production�1.3		Adobe Illustrator® Layer Support
	1. 		Production�1.4		JIG Templates
	1. 		Production�1.4		JIG Templates
	1. 		Production�1.4		JIG Templates
	1. 		Production�1.5		Enhanced print while RIP
	1. 		Production�1.6		Output Size Compensation per preset
	1. 		Production�1.6		Output Size Compensation per preset
	1. 		Production�1.7		Output Channel Preview
	Slide Number 23
	2. Color Management�	
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.1		G7 Certification
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.2		DeviceLink Profiler
	2. 		Color Management�2.3		Custom Ink Sets (DYESUB only)
	2. 		Color Management�2.3		Custom Ink Sets (DYESUB only)
	2. 		Color Management�2.3		Custom Ink Sets (DYESUB only)
	2. 		Color Management�2.4		Adjust Color Transformation with Color Mappings
	2. 		Color Management�2.4		Adjust Color Transformation with Color Mappings
	2. 		Color Management�2.4		Adjust Color Transformation with Color Mappings
	Slide Number 54
	3. Contour Cut�	
	3. 		Contour Cut�3.1		Manual Contour Cut Offset�
	3. 		Contour Cut�3.2		Custom Contour Cut Line Name and Color�
	3. 		Contour Cut�3.2		Custom Contour Cut Line Name and Color�
	3. 		Contour Cut�3.2		Custom Contour Cut Line Name and Color�
	3. 		Contour Cut�3.3		Artboard Contour Cut�
	3. 		Contour Cut�3.3		Artboard Contour Cut�
	3. 		Contour Cut�3.4		Cut Jobs with Barcode kept in hold��
	3. 		Contour Cut�3.5		Graphtec Barcode Support��
	3. 		Contour Cut�3.6		Summa/HP OPOS Xtra Mark��
	3. 		Contour Cut�3.7		Contour Cut line preview in Production Manager��
	Slide Number 66
	4. Extras�	
	4. 		Extras�4.1		Improvement to Job Info and Job Template���
	4. 		Extras�4.1		Improvement to Job Info and Job Template���
	4. 		Extras�4.1		Improvement to Job Info and Job Template���
	4. 		Extras�4.1		Improvement to Job Info and Job Template���
	4. 		Extras�4.2		User Data Backup���
	4. 		Extras�4.2		User Data Backup���
	Slide Number 74
	5. 		Feature Overview�		Production���
	5. 		Feature Overview�		Color Management���
	5. 		Feature Overview�		Contour Cut���
	5. 		Feature Overview�		Extras���
	Slide Number 79

